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Technical Support

For technical support in the U.S., please call toll-free at 1-800-638-8663.
For technical support outside the U.S., please visit the BD Web site at:

http:\\www.bd.com/support/contact
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System Configuration

For optimal performance, it is recommended that the system configuration consist of an MS-DOS
compatible computer, Pentium 90 Microprocessor with at least 16 MB RAM (32MB of RAM is
preferred).

The minimal system requirements are:

MS-DOS compatible computer, Intel 486 Microprocessor

16 MB RAM

Microsoft Windows (Win95, Win98, Win NT 4.0, Win2000, or WinXP)
CD-ROM/CDRW drive

Microsoft mouse or a mouse with a Microsoft mouse compatible driver
Microsoft ODBC drivers Version 2.00 (16 bit).

A keyboard with a numeric keypad.
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Installation of
BBL Crystal™ MIND

Determine if you are installing from the BD website or from CD. Go to the correct section below to find
the appropriate instructions. Follow the instructions in that section, then continue the installation in the
section named “& For all.”

Installing from the BD website:

Note that the instructions below may vary slightly depending upon the version of Windows you are
running.

e Go to the BD website with software downloads at: www.bd/com/ds/technicalCenter/
software.asp.

e Click on the “Crystal MIND” link to register your software; or if your software is already
registered use the “enter it here” link.

« Once your registration has been validated, a new page appears for downloading the Crystal
MIND software. To download, click on the “Crystal MIND” download link.

e The File Download - Security Warning window will be displayed. Click “Run” to continue.
e The Internet Explorer - Security Warning window is now displayed. Click “Run” to continue.
e Continue below at the 4 symbol.

Installing from CD:

e Toinstall from CD, insert the CD into the CD-ROM or CDRW drive.
e Double-click the “My Computer” icon on the desktop.

» Double-click the icon for the CD-ROM/CDRW drive. (Depending on the OS version, the icon
may be labelled “CD Drive,” “CD-RW Drive,” Compact Disc X:,” etc.)

* Double-click the “MIND” folder.
» Double-click the “SETUP.EXE” icon.
e Continue below at the 4 symbol.

8 For all

« For a new installation, a message is displayed asking you to install the application. For an
upgrade, a message is displayed asking you to update the existing application.

e Click the “OK” button to install the Crystal MIND Software.

A message is displayed asking if you plan to connect a BBL Crystal AutoReader. If you plan to
connect to an AutoReader, select “Auto Crystal.” You are then asked to which serial
communications port it will be attached. If you do not know the port at this time, select Com
Port 1. You can change this setting after installation (See Section 11.0 - Configuration). If you
are not connecting to an AutoReader, select “Manual Crystal.”

»  After selection, click “OK” to continue.

* For Windows 2000 (only), a message appears regarding the amount of memory in your
system. You can disregard this message and simply click the “OK” button.
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* The program files are then copied to your hard disk.
* The End Crystal installation screen is displayed. Click the “OK” button.
» A program group is created during the installation called BBL Crystal MIND.
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Installation of ODBC
Database Driver

You do NOT have to install the Access 2.00 ODBC drivers_ if you had a previous version of BBL
Crystal MIND installed OR if vour PC is a U.S. BD laptop.

Determine if you are installing from the BD website or from CD. Go to the correct section below to find
the appropriate instructions. Follow the instructions in that section, then continue the installation in the
section named “¥ For all.”

Installing from the BD website:

Note that the instructions below may vary slightly depending upon the version of Windows you are
running.

» Click the “ODBC Installation” link on the BD website. (On the site after your registration has
been validated.) The “File Download” window will be displayed. Click “Open” to access the
installation.

» Click the “Install” icon in the WinZip window to start the installation of the ODBC. If this icon is
not visible, locate the “setup.exe” file and double-click on the file name.

» The WinZip Caution window is displayed. Click “Yes” to continue.
* The Install window is now displayed. Click “OK” to continue.
* The Open File-Security Warning window is now displayed. Click “Run” to continue.

» Continue below at the 4 symbol.
Installing from CD (Windows 95/98/NT4.0/2000/XP):

» Toinstall from CD, insert the CD into the CD-ROM or CDRW drive (if not already inserted).
»  Double-click the “My Computer” icon on the desktop.

» Double-click the icon for the CD-ROM/CDRW drive. (Depending on the OS version, the icon
may be labelled “CD Drive,” “CD-RW Drive,” Compact Disc X:,” etc.)

» Double-click the “ODBC” folder.
» Double-click the “SETUP.EXE" icon.
»  Continue below at the & symbol.
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4 For all

 The Microsoft ODBC Setup Welcome screen is displayed. Click the “Continue” button.

 The Install Drivers screen is displayed. Select Microsoft Access Driver (*.mdb) from the
list, then click the “OK” button.

» The files are then copied to your computer.
» The Data Sources screen is displayed. Click the “Add” button.

e The Add Data Source screen is displayed. Select Microsoft Access Driver (*.mdb) then
click the “OK” button.

Note: Make sure to select the data source listed above, do not select any data source with
“(32 bit)” in the name.

« The ODBC Microsoft Access 2.0 Setup screen is displayed. In the Data Source Name field,
type the following command as it appears below:

BBL Crystal Glue

* Click the “Select” button in the Database section of the window.
» The Select Database screen is displayed. In the Database Name field, type the following:
C:\CRYSTAL\GLUE . MDB

¢ Click the “OK” button.

e The ODBC Microsoft Access 2.0 Setup screen is redisplayed. In the System Database
area, click the “Database” radio button, then click the “System database” button.

« The Select System Database screen is displayed. In the Database Name field, type the
following:

C:\CRYSTAL\ SYSTEM . MDA

* Click the "OK” button.
» The ODBC Microsoft Access 2.0 Setup screen is redisplayed. Click the “OK” button.

» The Data Sources screen is displayed with the data source that you just added. You will now
need to add another data source. Click the “Add” button.

» The Add Data Source screen is displayed. Select Microsoft Access Driver (*.mdb) then
Click the “OK” button.

Note: Make sure to select the data source listed above, do not select any data source with
“(32 bit)” in the name.

» The ODBC Microsoft Access 2.0 Setup screen is displayed. In the Data Source Name field,
type the following text as it appears below:

BBL Crystal CORE Id

* Click the “Select” button in the Database section of the window.
» The Select Database screen is displayed. In the Database Name field, type the following:
C:\CRYSTAL\CORE _ID.MDB

¢ Click the “OK” button.

« The ODBC Microsoft Access 2.0 Setup screen is displayed. In the System Database area,
click the “Database” radio button, then click the “System database” button.
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The Select System Database screen is displayed. In the Database Name field, type the
following:

C:\CRYSTAL\ SYSTEM . MDA

Click the “OK” button.
The ODBC Microsoft Access 2.0 Setup screen is displayed. Click the “OK” button.

The Data Sources screen is displayed with two lines corresponding to ‘BBL Crystal CORE Id’
and ‘BBL Crystal Glue.’ Click the “Close” button.

The Microsoft ODBC Setup screen is displayed with the message set up succeeded! Click the
“OK” button.

L-005355(J)
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Troubleshooting

The following describes problems that can occur during the operation of the BBL Crystal™ MIND
software. If you need further assistance, please call your BD Technical Services Representative (See
Technical Support section at the beginning of this manual).

Message Index

| Message Text and/or Resolution

Error:
Shadow Application
Error during installation
of the Crystal MIND
software.

Error: Some panels are
not displaying on the
Review screen

Error: Device
Unavailable

Error: Data is not being
printed out in the
Recapitulative Report

14

An alternate installation method for the Crystal MIND software needs to be
executed.

Click the “Alternate Install” link on the Crystal MIND website or run the
“setup.exe” program in the “Alternatelnstal\MIND” folder on the CD to install
the Crystal MIND software.

The Crystal MIND software was designed to only show a default of the last 30
days-worth of panels. This value can be increased. See Section 11.2 - Data
Review Period.

The reader may not be turned on or is not connected to the correct com port.
Switch on the power on the back panel of the reader. Verify the connection
between the com port and the serial cable. The proper com port may not be
specified in the Crystal MIND configuration file. Refer to the online FAQ
document (FAQ #14) on how to determine the correct com port setting. Refer
to Section 11.0 - Configuration on how to change the com port setting in the
Crystal MIND configuration file. The computer may need to be rebooted after
the initial configuration of the AutoReader.

The “Short Date” setup for your computer must have a 4-digit year format.
Refer to the system help for your computer on how to change this setting or
call BD for assistance.

The date range of this report requires a 4-digit year to be entered. For
example, you must enter “11/13/2002” instead of “11/13/02.”

An unexpected error has occurred in the BBLCrystal MIND Application. The
following information is important in determining the cause of this error.

PLEASE CONTACT BD FOR ASSISTANCE.
There are too many records to display in the list.

The list of displayed records will be TRUNCATED.

L-005355(J)



BBL Crystal™ MIND User’s Guide

15

20

21

22

23

25

26

72

There are invalid characters in the entered data. Only standard alphanumeric
characters are allowed. You may not use the " or the | characters.

Cannot add, modify or switch to another panel without all the information
entered.

The profile number is not complete.

The number of equivocal reactions is limited.

Maximum:
The panel cannot be completed.

The Database is LOCKED exclusively by another application. The BBL
Crystal can not be executed at this time.

Please try again later.

An Error occurred while launching the Batch Identification program.

This error can occur when clicking on BATCH ID or the ID button. The ID
Engine has returned an error to Crystal MIND. EXxit Crystal MIND before
proceeding with the possible resolutions.

Verify that ODBC has been setup correctly. Refer to the document How to
Verify ODBC Drivers on the BD website. Try running Crystal MIND again. If
the error still persists, proceed below to the next possible resolution.

Run the Repair_Compress Database Utility in the Crystal MIND Program
Group (Start>Programs>Crystal Mind>Repair Compress DB). Try running
Crystal MIND again. If the error still persists, proceed below to the next
possible resolution.

Using Windows Explorer or File Manager, copy the following database files
from c:\crystal\database to c:\crystal:

Taxonomy.mdb

Core_id.mdb
Glue.mdb

Try running Crystal MIND again. If the error still persists, please CONTACT
BD FOR ASSISTANCE.

The database of the ID engine is corrupt, the application will terminate.

This error can occur when clicking on Batch ID or the ID button, or upon
startup of the Crystal MIND application. The ID Engine has returned an error
to Crystal MIND.

Follow resolution above for error 26.
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75

76

79

80

81

83

88

91

94

95

An invalid Date was entered.

Use the “short date” format configured in your Windows control panel for Date
Format. You must use a “/” to separate month, day and year.

The FROM Date must be before the TO Date.
A Failure has occurred while attempting to open the AutoReader Drawer.
A Failure has occurred while attempting to close the AutoReader Drawer.

A timeout has occurred waiting for the AutoReader to respond.

The reader may not be turned on or is not connected to the correct com port.
Switch on the power on the back panel of the reader. Verify the connection
between the com port and the serial cable. The proper com port may not be
specified in the Crystal MIND configuration file. Refer to the online FAQ
document (FAQ #14) on how to determine the correct com port setting. Refer
to Section 11.0 - Configuration on how to change the com port setting in the
Crystal MIND configuration file. The computer may need to be rebooted after
the initial configuration of the AutoReader.

The panel readings received from the AutoReader were corrupted. Please re-
scan the panel.

This message is displayed when the readings were corrupted when sent from
the AutoReader to the Crystal MIND PC. Re-scanning the panel should
correct the problem.

The Crystal AutoReader is currently in WARM-UP mode. This process takes
approximately 10 minutes from the time the AutoReader is powered on. The
amount of time remaining before the AutoReader is available for use is listed
below.

The Reference Test has FAILED.

At the end of the message will be information that will indicate why the
Reference Test failed.

A “Visible Failure” message prior to a set of numbers indicates the White
lamp failed and will need replacing.

A “UV Ref Values” message prior to a set of numbers indicates the UV lamp
failed and will need replacing.

If either lamp has been replaced recently and is still giving an error message,
the Crystal MIND error log can be sent to BD for evaluation.

PLEASE CONTACT BD FOR ASSISTANCE.
Offline results must be entered prior to scanning an ENF panel.

The UV lamps are stabilizing. Please try again in:

10
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10007

103

106

107

228

229

231

232

234

237

239

244

293

294

602

611

612

613

616

A failure has occurred while accessing the error log file. The message will not
be saved to the log file.

PLEASE CONTACT BD FOR ASSISTANCE.

An error has occurred while attempting to print the message. Message will
not be printed.

PLEASE CONTACT BD FOR ASSISTANCE.

A failure has occurred while displaying an error message: The following is the
previous error message:

You have entered in an incorrect password for user:
You typed in two different new passwords.

The password you entered is invalid.

The User Name you entered does not exist.

You can not delete the currently logged in user.

You must enter both a first and last name.

The USER NAME entered matches a pre-existing user. USER NAMES must
be unique.

You can not have just spaces for a Password!

Reset Password to Last &Name.

Initial Password set to Last &Name.

Insufficient memory to run the Identification.
Unidentified Error.

Could not connect to the data source.

The data source is not compatible with this application.
Failed QC.

The UV bulb on the reader has FAILED and must be replaced by a Becton
Dickinson Service Representative. Panels can not be read by the Crystal
AutoReader until the bulb has been replaced.

This message occurs when the Source Monitor readings from reading a
regular panel are out of range. The UV bulb needs to be replaced.

PLEASE CONTACT BD FOR ASSISTANCE.

L-005355(J)
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10008

10009

10010

10011

The UV control well has readings out of range. Possible causes for this panel
error are the following:

1. Laboratory temperature outside range of 64.4 - 89.6 degrees Farenheit.
2. A bubble in the control well (Location - 4A)
3. The UV bulb on the reader has FAILED.

This message occurs when the UV Control well on the panel has a value out-
side an acceptable range.

Verify that the laboratory temperature is within the required range of 64.4 -
89.6 degrees Farenheit.

Verify that there are no bubbles in the control well (location 4A) of the panel.

If any of the problems above exist, a new panel must be used. If the error
persists, the UV bulb may need to be replaced.

PLEASE CONTACT BD FOR ASSISTANCE.
The UV Control well has readings that are almost out of range. Please check
the control well (Location - 4A) for bubbles. The UV bulb on the reader may

need to be replaced by a Becton Dickinson Service Representative. Your
results from your reader are VALID, but you must contact BD for assistance.

This message occurs when the Source Monitor readings from reading a
regular panel are almost out of range.

The UV bulb needs to be replaced.

PLEASE CONTACT BD FOR ASSISTANCE.

The white bulb on the reader needs to be replaced by a Becton Dickinson
Service Representative.

This message occurs when the readings from a regular panel do not have
enough variability.

The white bulb needs to be replaced.

PLEASE CONTACT BD FOR ASSISTANCE.

Read the REZ reaction manually and enter the result.
Blue to Purple = NEGATIVE result

Bright Pink = POSITIVE result

L-005355(J)



1.0 BBL Crystal™ AutoReader

The Crystal MIND Software can be used with a BBL Crystal AutoReader. The AutoReader allows
automatic reading of panels instead of manually reading the panels with a BBL Crystal PanelViewer
(See Section 4.6 for details).

If you do not have an attached BBL Crystal AutoReader, then proceed to Section 2.0, otherwise
continue reading below.

CAUTION

Protection provided by this instrument may be impaired

if the equipment is used in a manner not consistent with
instructions in this manual.

1.1 Setup
1.1.1 Connecting the Power Cable

The BBL Crystal AutoReader requires a power cable to be connected. The power cable connects
from the back of the AutoReader to the wall outlet.

1.1.2 Connecting the Serial Communications Cable

The serial cable connects from the back of the AutoReader to the PC that contains the BBL Crystal
MIND software. Connect the larger (25-pin) end of the provided serial cable to the back of the
AutoReader in the port labeled “DATA” and connect the other end (9-pin) to the serial/com port on
the back of your PC. The serial port is labeled as follows:

OIO]

L-005355(J) 13
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For laptops or computers that do not have a serial port, a USB to serial converter cable is needed
(not supplied with the AutoReader.) Plug the USB end of the converter cable into a USB slot on the
PC and the serial end of the converter into the 9-pin end of the AutoReader cable. Plug the other
end of the AutoReader cable (25-pin) into the back of the reader.

The BBL Crystal MIND software communicates with the AutoReader using the serial/com port
selected during installation. If this setting needs to be changed, see section 11 - Configuration for
details on how to change the setting. Note: If there is only one serial/com port on the back of your
PC, then itis “Com Port 1.”

1.1.3 Power switch

The power switch is located on the back panel of the Reader.

| = Power ON O = Power OFF

1.1.4 Upgrade

1.2

If the BBL Crystal AutoReader is being replaced, you must shut down the Crystal MIND software
application prior to installing the new reader. Once the new reader is connected, restart the Crystal
MIND application.

Warmup Cycle

When powered on, the reader will turn on its internal lamps and begin a “Warmup” cycle that takes
10 minutes to complete.

If an attempt is made to open the drawer (by entering the Data Entry Screen), an error message
will be displayed indicating that the reader is warming up. The message will indicate the number of
minutes and seconds remaining before the warmup cycle is complete.

If you attempt to scan/read a panel during this warm-up cycle, an error message will be displayed
indicating that the reader is warming up. The message will indicate the number of minutes and
seconds remaining before the warmup cycle is complete.

14
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1.3 Automatic Lamp Shutdown

The reader will automatically turn off all internal lamps after 1 hour of inactivity. The purpose of the
“shutdown” is to increase the lifetime of the internal lamps. If the reader is in the “shutdown” mode,
any attempts to open the drawer of the reader or to scan a panel, will transition the reader into the
Warmup mode. As stated above, the Warmup mode will take 10 minutes to complete.

1.4 Panel Orientation

Proper placement of the Crystal panel into the BBL Crystal AutoReader is essential for correct
organism identification. The label on the Crystal panel should be facing down and pointing towards
the front of the drawer. There will be a label on the inside of the drawer indicating where the label
of the panel should be placed. The panel label should be directly touching the indicator on the
inside of the drawer.

1.5 Exiting the Data Entry Screen

It is highly recommended to exit the Data Entry Screen when not reading panels. The drawer of the
reader remains open while in the Data Entry Screen. This results in the lamps cooling down, which
could effect organism identification.

1.6 Reference Panel Testing

A Reference Panel has been provided with your BBL Crystal AutoReader. The Reference panel is
used to determine that the AutoReader is properly calibrated. It is recommended that you scan a
Reference Panel at least once per month. The Reference Panel should be kept in a protective
sleeve such as the one in which the panel was shipped. See section 10.0 for details.

1.7 Reader Maintenance
1.7.1 Cleaning the Diffuser Filter

The Diffuser Filter is the white glass plate on the bottom of the AutoReader drawer. This filter
will need to be cleaned periodically to insure accurate panel readings. Prior to cleaning the fil-
ter, you MUST power off the AutoReader and unplug it from the wall. You can clean it with
either a lint-free cloth or lens paper moistened with water or commercial lens cleaning solution.

1.7.2 Cleaning the Exterior Surfaces of the Reader

The external surfaces may be wiped clean with a soft cloth or sponge moistened with water
and/or mild detergent. If desired, the outer surfaces can be wiped with a 10:1 dilution of house-
hold bleach in water. In all cases, care should be exercised to prevent liquid from entering the
AutoReader.

L-005355(J) 15
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1.7.3 Bulb Replacement

The AutoReader contains two internal lamps, a white light bulb and a UV light bulb. Should
either bulb burnout, please call U.S. BD Technical Services to have the AutoReader replaced
with a working reader. Lamp replacement should only be performed by qualified personnel, as
replacing the lamp without subsequent re-calibration of the reader can cause the system to
report inaccurate test results.

NOTE

Do not attempt to open the reader and replace the bulbs. Call BD for
assistance.

1.8 Removing a Jammed Panel

If a panel should get jammed in the AutoReader, turn off the power to the reader and remove the
panel. Turn the power back on and re-scan the panel. Note: After turning the power back on, the
Reader must go through its 10 minute Warmup cycle.

CAUTION

Do not attempt to remove a panel with the power on.

1.9 Biohazard Warning — Infectious Materials

Inoculated panels may contain viable pathogenic organisms cultured from the initial specimen.
Panels should be handled and disposed of in a manner consistent with regulations and
procedures proscribed by local health authorities. Use of gloves is recommended.

1.10 Electrical Requirements

Input Voltage 100 - 240 VAC, single phase
Input Current 0.37 A
Input Line Frequency 50/60 Hz

16 L-005355(J)
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1.11 Environmental Requirements

Fluorogenic area

Non Operating Storage

Temperature -17.8°C - 65.0°C

Humidity 10% — 90% relative humidity (non-condensing)

Operating Conditions
18°C - 30°C

Temperature Microbiological efficacy may be compromised
above 40° C.

Humidity 15% — 90% relative humidity (non-condensing)
Level surface, no direct sunlight, no direct

Locations heat. Typical laboratory lighting (up to 150 foot-
candles).

Altitude 0 —2,000M

Installation Category Il and Pollution Degree 2 as per IEC 664

L-005355(J)
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2.0 Introduction to BBL

Crystal™ MIND

The BBL Crystal MIND System for Microbial Identification is designed to identify clinically significant
human pathogens. The purpose of this software is to provide the identification of the unknown
organism run in a panel by mathematically interpreting the BBL Crystal profile number and off-line test
results and evaluating the result against the organisms contained in the appropriate BBL Crystal™
database.

By providing the interpretative component of the BBL Crystal ID System in this manner, the user has
access to the proper interpretation of all BBL Crystal profile numbers. The user has full access to the
calculated parameters used in the ID process.

Additionally, a differentiation database is included to assist in resolving those pairs of organisms that
occasionally can not be differentiated on the basis of the profile and off-line tests alone.

2.1 BBL Crystal™ MIND Overview

This application is designed to support the BBL Crystal E/NF, Anaerobe, Gram Positive, Rapid Gram
Positive, and N/H Identification panels.

The following features are included to optimize the workflow and ease of use:

Context panel image makes the product more user friendly.
Keyboard and Mouse Data Entry modes: 2 modes for adaptability.
Equivocal reaction reading management for more flexibility.

Batch Identification mode for increased productivity.

Result review easier to access.

Reports printed for archive.

Password security for protection of the panel information.

Long term storage of information in a database.

L-005355(J)
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2.2 Workflow

DATA ENTRY < Edit profile REVIEW
- specimen details - Identifications
- virtual panel - Statistics
Batch ID

PRINT REPORTS

There are two workflow paths that you can follow. You can use one or the other or a combination of
both. One of the workflows requires the use of a BBL Crystal™ AutoReader and the other requires a
BBL Crystal™ PanelViewer.

The following is an overview of the steps required to enter and identify a crystal panel.

1 If you have an attached BBL Crystal™ AutoReader, scan the panel using the AutoReader. The
results are automatically displayed on the Data Entry screen in the virtual panel. Skip to Step
3.

2 If you have a manual BBL Crystal™ PanelViewer, read the reactions of the panel using the
PanelViewer and record the reactions in the virtual panel on the Data Entry screen.

Launch Batch Identification System (more than one panel can be identified at the same time).

Review results (organism identifications, statistics, special messages) through the Review
screen. An EDIT function allows correction of potential errors while reviewing the 1d(s)
suggested by the system.

5 Reports can be generated and printed.
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3.0 Getting Started

3.1 Introduction

After the installation of BBL Crystal™ MIND, a new program group BBL Crystal MIND is created.

[@ Lotus Applications b
[ Mcafee >
[@ Microsoft Office 3
' Internet [/ Microsoft SQL Server »
¢ Internet Explorer [@ Microsoft Visual Basic 6.0 4
o) E-mail [@ ft Web Publishi
! el Microsoft Web Publishin: 3
'-:l__l__/l Lotus Notes ¢
I/ Mysoftware b
PS Export Interfaces [@ ODBC 4
[@ Parts Tracker 3
Microsoft Office Excg [@ Farts Tracker V8.0 »
B [@ Phoenix Simulator 4
| crystal MIND
LT o JBL Crystal MIND & MIND Setup
1 _ [ PYCS Tracker v | B Crystal MIND
G Faint
[@ Quest Software 3 @ Repair_Compress Database
o .
r@ Microsoft Visual Basi [@ QuickTime 4
[@ sAP FrontEnd »
Microsoft Office Accy
2003 [@ Sheridan »
[T snaglts »

AllP »
e [@ Sonic ¥

@ startup >

@ winzip »

o Fad
+y Start ) B8 Adcbe Reader &
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The MIND Setup option allows you to configure the default Data Entry Mode (Keyboard or Mouse),
configure the number of days worth of data to keep current in your worklist and the serial
communications port setup for the AutoReader. (See Section 11 — CONFIGURATION for details)

3.2 Selecting a Language

When you launch the BBL Crystal™ MIND application, a screen is displayed that allows you to select
the language in which you want to work. This window is displayed only the first time that the application
is run.

BELCrystal MIND

¥5.05A

" Please select a language :

E I " [talian
" French = Spanizh

E German E xit

Do not change the operating language of the application once it has been selected. Doing so will result
in the database containing results in multiple languages.

3.3 Main Menu

The Main program contains the following menus and submenus:

BELCrystal Microbiology INteractive Database

File DataEntry BatchID Review Reports Setup Percentage Reference Test

File
Exit
Data Entry (Displays a Screen to enter panel reactions)
Batch ID (Launches the ID system to identify organisms on the panels)
Review (Displays a Screen to review panel ID results)
Reports (Sends specified report to the printer)
Specimens reports

Recapitulative report
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SetUp (Adds / Edits system users and passwords)
Change Password
Account Password
Percentage (Displays a Screen containing the percent charts for all panels)

Reference Test (Displays a Screen to allow running a Reference Panel Test)

3.4 Error Messages

When an error message is displayed on the screen, you can print the message by clicking the “Print”
button.

CRYSTAL User Information 10/25/2010 3:05:12 PM

CRYSTAL: 21 - The profile number iz not complete.
. 0K Print

If an error message occurs for which you need assistance, please print the error message so that a BD
Technical Services representative can better assist you.

The Troubleshooting section provides a complete listing of error messages.

3.5 Security

3.5.1 Default User Name and Password

Security is available in the BBLCrystal MIND application. The security consists of a username and
password that you enter when launching the application. When the product is installed, the default
USERNAME is “BBL Crystal” and the default PASSWORD is “BBL.”

3.5.2 Changing the Password

Once the application is installed and running, you can change the password. To change the
password, you must select the Setup/Change Password menu.

Once the Change Password screen is displayed, you must:

» Enter the current password in the Old Password field.
« Enter the new password in the New Password field.
» Enter once again the new password in the New Password Verification field.

(See section 8.0 - SET UP for more details)
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4.0 Data Entry

4.1 Introduction

To enter a new panel, select the Data Entry menu. This displays the Data Entry screen. The Data Entry
screen allows you to enter up to seven different panels for an Accession. Each panel must be a different
panel type. If you have a BBL Crystal AutoReader attached to your PC, a “Scan” button appears on the
screen and the drawer of the AutoReader automatically opens. Once the panel is scanned, the
biochemical reactions are automatically displayed on the screen. If you have setup to read your panels
manually, the “Scan” button does not appear on the screen and you have to manually enter the
biochemical reactions of the panel after reading the reactions via a BBL Crystal PanelViewer.

BBLCrystal Microbiology INteractive Database [Data Entry] .

File BatchID Review Reports Setup Percentage

Accession #

332288

Add Patient Id Patient Hame
|288111118 | |JDHN DOE

GP | RGP

Clear ENF ANR | ANE | ANR
CDC | 3CH | ALT

b |

[(ATBICIDTETFIGTHTTITI] ABCDEFGHI Y

° 10000000000 MMM

ARA MNS SUC MEL RHA SOR MNT ADD GAL INO

QQQQQQOQQQ @® Keyboard Entry

Scan PHO BGL NPG PRO BPH BXY AAR PHC GLR NAG

BQQQQQQQQGO O Mouse Entry

GGL ESC PHE URE GLY CIT MLO TTC ARG LS

noan

Llose

Dxidase
[+
x -
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4.2 Data Entry Overview

To enter results for a panel, follow these steps:

4.3

Enter the Accession Number.
Enter an optional Patient Id and Patient Name.
Select a Panel Type.

Enter the biochemical reactions of the panel or place the panel in a BBL Crystal AutoReader
and click the “Scan” button.

Enter any required offline test results.
Click the “ADD” button.

To calculate an organism ID and review the ID results for all the newly entered panels: click the
“ID” button, then go to the Review screen.

NOTE

For detailed information on how to perform the above steps, proceed with
the following sections.

Mandatory / Optional Fields

When the screen is displayed, the focus is on the Accession Number field. You must enter
data in this field to save a panel, as it is mandatory. The information is not saved if this field is
empty.

There is the option of entering the Patient Id and Patient Name, but these two fields are not
mandatory. If you enter a Patient Id, you do not have to enter a Patient Name. If you enter a
Patient Name, you must enter a Patient Id. If the patient already exists in the database, when
the Patient Id is entered and “Enter” is pressed, the Patient Name is automatically displayed in
the corresponding field. When the Patient Name is entered, a search of the database is not
performed for an existing patient, so the Patient Id must be entered manually.

All biochemicals of the selected panel must be filled with a positive or negative reaction. The
information is not saved if the panel is not complete.

The associated offline test results must be entered as well. The information is not saved if
offline test results are not entered.

4.4 Entering Multiple Panels for a Single Accession

You have the option to add multiple different panels for the same accession number. Enter the Accession
Number and optionally, Patient Id and Name. Select one panel type and complete it by entering all the
biochemical reactions. Enter the associated offline test results. Click on another panel type and then
complete it. The general information (Accession Number, Patient Id or/and Name) are still displayed on the
screen. Follow this process for the different panels for this accession number.

26
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You can always return to a panel already entered for this accession number (prior to saving), by clicking
on the desired panel type and the results will be displayed on the screen.

NOTE

You cannot switch from the current panel to another one if the current
panel is not entirely completed. This means the virtual panel and the
offline test results have to be completed. A message is displayed on the
screen if switching is attempted prior to completing the current panel.

4.5 Virtual Panel

The Virtual Panel is the graphic display in the middle of the screen that shows the biochemical layout of
the selected panel marked by columns A through J and rows 4, 2 and 1. When the virtual panel is initially
displayed, all biochemical reactions are blank. Positive and negative reactions are filled in the positions of
the virtual panel through various methods which are described in subsequent sections.

45.1 Interaction of Virtual Panel and Profile Field

The profile field and the virtual panel are interactive. When a position of the virtual panel is filled,
the corresponding number is automatically added in the profile field, and vice versa: when a figure
is added in the profile field, the corresponding sign appears in the virtual panel.

(AlB|CIDIEJF]G[H]T[J] FGHI

10000000000 BoAas

ARA MMS SUC MEL RHA 50R MWT ADO GAL MO

QOO@OOO@@C) [ 6 Kesboard Enty

_ PHO BGL MPG PRO EPH Bxy AdR PHC GLR MAG
! Mouse Entry

@O Y

GGL ESC PHE URE GLY CIT MLO TTC ARG LYS

-

[~

4.5.2 Selecting a Panel Type
The virtual panel allows the selection of up to seven different panel types.
ENF BBL Crystal Enteric/NF
ANR/CDC BBL Crystal Anaerobe from CDC Blood Agar
ANR/SCH BBL Crystal Anaerobe from Schaedler
ANR/ALT BBL Crystal Anaerobe from Alternate Blood Agars

GP BBL Crystal Gram Positive
RGP BBL Crystal Rapid Gram Positive
NH BBL Crystal Neisseria/Haemophilus
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To select a panel type, click on the panel abbreviation. To select a panel type using the keyboard,
place focus on the panel type section, use the left and right arrow keys to highlight the desired
panel and press “Enter.”

4.5.3 Fluorescent Panel Layouts

There are two basic types of panels, Fluorescent and non-Fluorescent panels. The fluorescent
panels have a grey circle on the 15! row/1st column (4A) of the virtual panel (FCT = Fluorescent
ConTrol). This position cannot be filled with a sign.

The fluorescent panels are broken into two areas, the Chromogenic area and the Fluorogenic
area. The Chromogenic area is shaded in orange with the column numbers in red. The
Fluorogenic area is white with the column numbers in black.

Fluorogenic area Chromogenic area

[ATETEDIETFIGIH]TT[J]

FCT FAM FBM FG& FME FPH DIS AGA AGL AFU

FAR FSE FGL FFY FCE FLE FUR MNPG NAG BGL

= & &

FHI FIS FalL FLY Fxv FSC Pv0 PHO PRO ala

4.6 Methods for Entering Panel Reactions

There are four methods of entering positive/negative reactions of the biochemicals on a panel. The
following paragraphs describe each of the methods. Note that the first method is only available if you
have a BBL Crystal AutoReader attached to your PC.

4.6.1 Automatic Reaction Entry

If you have an attached BBL Crystal AutoReader, place the panel in the AutoReader, select the
appropriate panel type on the screen, and click the “Scan” button. The panel is scanned and the
positive and negative reactions are automatically displayed in the virtual panel on the Data Entry
screen. You must enter the offline results manually.

The following three sections describe the remaining three methods of reaction entry. Note: Any of
the following methods can be used to modify the reactions received from the Reader.

4.6.2 Profile Field Entry

If you are manually reading panels, you have the option of entering the panel results by directly
entering the profile number in the Profile Number field. As the profile number is entered, the panel
reactions are automatically filled in the virtual panel.

After the selection of a panel type, the focus is on the first position (A) of the profile field. Using the
keypad, enter the first number of the profile. Focus automatically moves to the next position (B) in
the profile number field. Continue until all positions have been entered.

To move to a position in the profile number without typing a number, press the “Tab” key to move
forward and press “Shift” + “Tab” to move backward within the profile number field.

28
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4.6.3 Keyboard Entry

If you are manually reading panels, you have the option of entering the panel results using the “+” and “-”
keys on your keypad. To enter results using this method, you must select the “Keyboard” radio button.
This option is the default method when the Data Entry screen is entered. To change the default option,
see Section 11.0 — CONFIGURATION. When the “Keyboard” option is selected, you cannot use the
mouse to enter panel reactions in the virtual panel.

NOTE

If you have a laptop, you may need to press the “NumLock” key to enable
the keypad. The “+” and “-” keys on the keypad are the same keys as “P”
and “:” for the standard keyboard.

® Keyboard Entry
! Mouse Entry

Once you have selected the Panel Type of the panel to be entered and the Accession Number has
already been entered, focus is moved to the first position of the Profile Number field and a
question mark (?) is displayed on the virtual panel. The position of the (?) depends upon the
selected panel and is described below.

If the accession has not been filled, the focus moves to the Accession Number field after the Panel
Type has been selected since the Accession Field must be entered. If this occurs, enter the
Accession Number and press “Tab” or “Enter” until focus is on the first position of the profile number
field.

4.6.3.1 Entry Order

The order in which the panel positions are traversed as biochemical reactions are entered, is
dependent upon whether the panel is a fluorescent or non-fluorescent panel.

Non-Fluorescent Panels

The focus moves from left to right and from top to bottom as you enter each biochemical
reaction on the virtual panel.

([ATBICIDIETFIGITHITTJ]

Lo —

SRS MWNS SUC MEL RHA SOR MNT ADO GAL INO

&

FHO BGL MPG PRO BPH By &4R PHC GLR HAG

—fleca -

GGL ESC PHE URE GLY CIT MLO TTC ARG LYS
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Fluorescent Panels

The focus moves from top to bottom and left to right. The Chromogenic area is completed
first, and then the Fluorogenic area is completed.

Completed 2nd Completed 1st

AJBICIDYEIFIGIHIT [JD

=1

FCT FPH FTR FHO_TRE.SUL,

-9

=]~

[ ]

O
0
0

y

4.6.3.2 Modify Entered Reaction

There are two methods of modifying a reaction that has been entered: using the “Backspace”
key or switching to Mouse mode and using the mouse.

“Backspace” Key

The “Backspace” key allows you to modify the previous reaction. The focus goes back to
the last position entered and erases it. This method is best used when you make a mis-
take on the last entered reaction.

Using the Mouse

You must select the Mouse Entry option to enable the mouse. Clicking on the result with
the mouse makes the reaction change to the opposite value (positive becomes negative
and negative becomes positive).

To complete the panel reactions using the keyboard, you must select the Keyboard Entry
option again. The focus is placed after the last biochemical entered.

4.6.4 Mouse Reaction Entry

If you are manually reading panels, you have the option of entering the panel results with the
mouse. Using the mouse to enter biochemical reactions in the virtual panel offers greater flexibility
over using the keyboard. In order to enter panel reactions using the mouse, the Mouse Entry
option must be selected. The Keyboard Entry option is the default method when the Data Entry
screen is entered. To change the default option, see Section 11.0 - CONFIGURATION.

) K.eyboard Entry

You are not required to enter the reactions in any particular order when using the mouse. Just
place the mouse over the panel position to enter and click the left mouse button once to enter a
positive result and twice to enter a negative result.
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4.6.4.1 Completing a Row or Column

An entire row can be completed at the same time by clicking on the row indicator (4, 2 or 1). An
entire column can be completed at the same time by clicking on the column indicator (A, B,
C,...).

Column indicators

(AJB[CIDJETFIGIHTUITJ]

1O0O000O000

ARA MMWS SUC MEL RHA SOR MNT ADO GAL INO

1000000000

PHO BGL MPG PRO BPH By AR PHC GLR MAG

i-1+1-F

GGL ESC PHE URE GLY CIT MLO TTC ARG LYS

Row indicators

The following paragraphs describe various ways to complete the column or row.

e If the row or column is completely empty, clicking on the row or column indicator will
complete that row or column with “+” signs.

e If the row or column contains all “+” signs, then clicking on the row or column indicator
will complete that row or column with “~" signs.

« If the row or column contains all “-" signs, then clicking on the row or column indicator
will complete that row or column with “+” signs.

e If the row or column contains some “+“ signs and some “~" signs, then clicking on the
row or column indicator will complete that row or column with all “+” signs (converting
all “=" and empty positions to “+").

4.6.4.2 Completing Entire Panel — Complete Panel Button

When the Mouse Entry option is selected, a “Complete Panel” button is displayed that allows
the entire panel to be completed at the same time.

Complete Panel

The panel is completed differently depending upon the panel nature: Non-Fluorescent or Fluo-
rescent. The following paragraphs describe various ways to complete the entire panel based
on the panel nature when the “Complete Panel” button is clicked.

Non-Fluorescent Panel

If the entire panel is empty, the following message is displayed.
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CRYSTAL User Information 10/25/2010 3:27:25 PM

CRYSTAL: 27 - The Panel [or one area of the panel] has no reaction
specified

Click YES to complete with POSITIVE reactions
Click HO to complete with HEGATIVE reactions

Chck CAMCEL to stop the completing of the panel

Yes Ho ‘ LCancel ‘ Print

Clicking the “Yes” button fills all the positions with “+.” Clicking the “No” button fills all the

positions with “—.

”

If the panel contains some “+” signs and the rest of the positions are empty, all of the
empty positions are filled with “—” signs. The opposite is true as well. If the panel
contains some “—" signs and the rest of the positions are empty, all of the empty
positions are filled with “+” signs.

If the panel contains some “+” signs and some “-’signs, an error message is
displayed indicating that the panel cannot be completed using the “Complete Panel”
button.

Fluorescent Panel

Fluorescent panels contain two areas (Fluorogenic or Chromogenic). Each area is com-
pleted independently of the other. Each area uses the same rules as described for Non-
Fluorescent panels.

If an area is empty, then a message asking how to complete that area is displayed.
Pressing the “Yes” button fills all the positions with “+.” Pressing the “No” button fills all
the positions with “-.”

If an area contains some “+” signs and the rest of the positions of that area are empty,
all of the empty positions will be filled with “—.” The opposite is true as well. If an area
contains some “—" signs and the rest of the positions of that area are empty, all of the
empty positions will be filled with “+” signs.

If an area contains some “+” signs and some “~" signs, an error message will be
displayed indicating that the panel can not be completed using the “Complete Panel”
button.

4.7 Marking Equivocal Reactions

If you are unsure if a biochemical reaction is positive or negative, the biochemical can be marked as
equivocal. You must still give the biochemical a positive or negative result, but it can be marked so that it
is visually apparent that the reaction is questionable.

To mark a biochemical as equivocal, first enter the positive or negative result and then click once on the
biochemical test name abbreviation. The biochemical test name becomes yellow and highlighted in red.
If you are entering reactions using the Keyboard Entry mode, press “Control” + “+” or “-” while entering
the test reactions.
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To remove an equivocal mark, click on the biochemical test and the red highlighting is removed.

The Profile Number in the Profile field is not effected by the equivocal reactions. The Profile Number is
calculated normally using the positive and negative reactions.

NOTE

A maximum of three equivocal reactions is allowed in the virtual panel.

4.8 Offline Results Entry

Offline results must be entered in order to save the panel.

To enter a result for a given offline test, click on the result to the left of the box. A cross is displayed on the
box corresponding to this result. This must be done for each offline test.

To enter results for offline tests without using a mouse: after completing the virtual panel with “+” and “-”
keys, focus is on the first position of the offline result. The Arrow Keys allow you to switch to the different
results for a given offline test. “Tab” and “Enter” allow you to switch to another offline test.

" Gram Indole | [ Catalase
[+ Bacilli [+ Cocei M+ -
[~ Bacilli (- Cocci - -
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Some offline tests are radio buttons instead of checkboxes. Use the same rules described above to enter
the results.

NOTE

Some panel types may require the entry of offline results prior to scan-
ning a panel.

4.9 Saving an Accession

Clicking the “Add” button or pressing “Alt” + “A”, saves an Accession and all of its panels to the Crystal
MIND Database.

Before saving an accession, all the mandatory fields must be completed for each panel (accession
number, panel reactions, offline results). If one of the mandatory fields is not complete when the “Add”
button is clicked, an error message is displayed and the information is not saved.

When the “Add” button is clicked, the ...Please wait... message is displayed on the screen. You must wait
until the end of the process to continue to work.

The screen is cleared when the save is complete and the focus is placed on Accession Number field.

NOTE

If the same accession number is saved to the database at different times,
the panels of the accession number will not be associated. Since they
were entered at different times, they are considered to be two different

accession numbers.

4.10 “Clear” Button

If the “Clear” button is clicked, it clears the screen. A message is displayed asking you to confirm the
clear. If you click the “OK” button, the screen is cleared, including all panels entered for the current
Accession Number. You will lose any unsaved data. If you click the “Cancel” button, the screen is not
cleared and the Data Entry screen is re-displayed.

The focus is then in the Accession Number field. The Reaction Entry mode (Keyboard or Mouse)
remains the same.
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4.11 “Close” Button

If the “Close” button is clicked, the Data Entry screen is closed and the Main BBLCrystal MIND screen is
displayed.

If there is unsaved data on the screen, a message is displayed indicating that there is unsaved data on
the screen. If you click the “Yes” button, the Main screen is displayed and all data on the screen is lost. If
you click the “No” button, the data remains on the screen and the Data Entry screen is re-displayed.

4.12 “ID” Button

By clicking the “ID” button, the Organism Identification process is started.

It launches the Batch ID process to obtain identifications, statistics and special messages of all the
panels that have not passed through the Batch ID process. (see the next section — Batch ID, for details) .
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5.0 Batch ID

5.1 Introduction

The Batch ID process launches the ID Engine to obtain organism identifications, statistics and special
messages of the panels entered through the Data Entry screen that have not been passed through
the Batch ID process. This operation has to be initiated after adding panels in the Data Entry screen in
order to view Panel ID Results.

The Batch ID process is active from any screen menu (Main, Data Entry and Review screens)

BBLCrystal Mic. »biology INteractive Database

File DataEntry BatchID Review FReports Setup Percentage Reference Test

or from the “ID” button on the Data Entry screen.

| »

* Inthe Data Entry screen, several panels for a given accession can be entered. One or more
panels for different accession numbers can also be entered. At any point in time, the Batch Id
process can be launched. The Batch Id process does not have to be launched after each
Accession Save since the Batch ID process will launch the ID Engine for all panels that have
not been identified.

* When the Batch ID process is launched a message is displayed on the screen. You must wait
until the end of the process to continue to work.

Batch Identification In Process._. Please Wait. ..
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6.0 Review

6.1 Introduction

The Review Screen displays the panel results that were generated by the Batch ID Process. The
screen is divided in 2 main sections:

« At the top of the screen, all the panels that have not been printed and have been Batch Id
processed are displayed in a scrollable worklist.

* The remaining portion of the screen contains the results of the panel selected in the worklist.
The results include: Identifications with statistics (Biotype Validity and Confidence factor),
statistics and/or message notes.

When the user enters in this screen, the focus is on the first line of the worklist if there is at least one
panel displayed.
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BBLCrystal Microbiology INteractive Database [Review]

| -Worklist

File DataEntry BatchID Reports Setup Percentage
Profile Patient M ame A, i
4424644061 C JOHNSOM 827532
ENF 5664646051 H FREEMAN §27444
Print EMF 4765273153 J DELL 284737 =
ENF 67BbE7 7057 R BODKMAN 546732
EMF 3411310300 S REYNOLDS 537272
Delete ENF 5761673455 T SMITH 827218 |
- 4 »
[~ Dizgplay the Profile: aleady Printed List Sorted by
Sup. Test Patient Name @ Accession Mumber O
[ Current Record
Biotype ¥alidity | [ Confidence |
[1] Klebsiella pr iae ssp p liae i‘ | |
[2] Semnatia rubidaea | | |
Modify [3] Enterobacter cloacae | | |
The Crpstal ID Report is based on these statistics. Choosing an organism of the basis of these statistics is not
recommended.
Close
The Cipstal ID system reports these choices. Suppl tal testing is ded.
" BBL Crystal Enteric/NF 4.0
Profile I:I Dxidase |:| Indole |:|

6.2 Worklist

The worklist displays all the panels that have not been printed and have passed through the Batch Id
process. By default, the worklist is sorted by patient name. You have the option of changing the
default sorting of patient name to accession number by clicking the corresponding radio button below

the worklist.

Lizt Sorted by
’V Fatient M ame (@

Acoeszion Mumber O

The worklist displays the following information:

* The panel abbreviation

* An asterisk if a panel has equivocal results

»  The profile number

» The patient name (if it exists)

 The accession number
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Profile Patient Mame Accession Mumber

ENF 5664646051 H FREEMAN 827444 -
ENF 4765273153 J DELL 284737

ENF |= |5664646051 JOHN DOE 382288

EMF 6765677557 R BOOKMAN 546732

EMF 3411310300 5 REYNOLDS h37272

ENF h761673455 T SHMITH 827218 | d
L »

: - : List Sorted by
[ Dizplay the Profiles already Printed ’7 SO SN P ‘

If you would like to view panels that have already been printed, you must check the box, Display the
Profiles already Printed, which is located below the worklist. Panels that have not been printed are
removed from the list when this checkbox is checked.

The worklist displays by default, the panels of the last 30 days. You may change this period in the
Crystal.ini file, and replace the 30 by the desired number of days (See Section 11.0 —
CONFIGURATION for details).

6.3 Selecting a Panel in the Worklist

To select a panel in the worklist, use the up and down arrow keys or click the desired panel. Selecting
a panel highlights the entire panel line in the worklist.

Each time a panel line is highlighted, the results of the selected panel are automatically displayed on
the bottom portion of the screen.

6.4 Organism ldentification Results

The bottom portion of the screen displays the organism identification (up to three organisms), the
Biotype Validity, Confidence Value and Special Messages.

6.4.1 Organism Pushbuttons

Biotype VYalidity | [ Confidence

| /[1/] Klebsziella pneumoniae ssp pneumoniae I I:I

< [2] Semratia rubidaea ) | | | |

[3] Enterobacter cloacae | | | |

Each organism name acts as a button. When you click one of the buttons or enter the number
displayed between [square brackets], a screen is displayed containing additional information about
the identification. The following section describes the content of this screen.

6.4.2 Organism Information Screen

The following is a description of the screen that is displayed when an organism button is clicked.

» The first section contains Notes about the organism. There are reference numbers displayed
at the beginning of the Notes. The reference numbers (2 3 5) refer to the bibliography
displayed at the end of the list. In the example, the reference numbers are 2, 3 and 5. At the
end of the list, the 3 bibliographies are specified.
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BBLCrystal Microbiology INteractive Database [Review]

File DataEntry BatchID Reports Setup Percentage

Review

"~ Klebsiella p iae ssp p iae

2 3 5 :Important cause of nozocomial and community-acquired infections. Associated with lobar pneumoniae,
urinary and biliary tract infections, wounds and bacteremias. Yirtually limited to immunocompromised persons.

3: Balows, A, W.J. Hausler. Jr.. K.L. Herrman, H.D. Isenberg. Manual of Clinical Microbiology, Sth Edition.
American Society for Microbiology. Washington, D.C.

5 : Mandell. G.L. R.G. Douglas. Jr. and J_.E. Bennett. 1990. Principles and Practice of Infectious Diseases,
3rd. Edition. Churchill Livingstone Inc., New York.

-]

Previously known as:Klebsiella pneumoniae

Atypical
+: # PNP N-Acetyl-Beta-D-Glucozaminide
- / Gamma-L-Glutamyl-P-HA

« If the organism nomenclature has changed, the next section displays the previous
nomenclature. The nomenclature displayed on the Review screen is the new one. The
previous nomenclature is displayed on the Organism Information screen.

« If there are atypical results for some of the biochemical tests, the next section, named
“Atypical reactions for this organism in the system” is displayed. It contains all the biochemical
tests for which there are atypical results, and the obtained results (+ or -).

* To return to the Review screen, click the “Review” button.

6.4.3 Previous Nomenclature

If an organism pushbutton is surrounded in red, it indicates that the organism nomenclature has
changed since the previous version of BBL Crystal MIND.

[1] Weeksella viroza/Bergeyella
zoohelcum

The nomenclature displayed on the Review screen is the new one. The previous nomenclature is
displayed on the Organism Information Screen.
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6.5 Supplemental Testing

Clicking the “Sup Test” button displays the Differentiation Database screen where the organisms

identified for the current panel are displayed with their expected behavior on additional supplemental
testing. The numbers displayed on this screen represent the percent positive.

Sup. Test

Supplemental Test .
Organizm Mame wP MO CBE GE DW MR OR

Enterobacter cloacae 99 (95 | 99 1 1 5 | 96

Klebsiella pneumoniae ssp pneumoniae 98 1 98 1 1 10 1

Sermratia rubidaea 99 (85 |94 |90 (99 |20 | 1

Description of the Test Codes and Results

42 - Growth at 42 degrees Celsius
CE : Cellobiose

DN : DNase

GE : Gelatin

HS : H25

MO : Motility

MR : Methyl Red

MI : Mitrate

OR : Ornithine

[~ All Organisms Pogor Close

You can choose to display all tests or only the meaningful tests, (i.e. the tests for which there are clear
pos/neg results for the bacteria under consideration) by clicking the following button.

Ly

You can obtain supplementary test information even if the current panel did not produce an
identification. In this case, the supplementary tests are displayed for all organisms.

A Please Wait message is displayed on the screen while waiting for the supplementary tests screen to
display the results.

You can obtain more test results with all the organisms by checking the All Organisms check box.
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The meaning of each biochemical test and each result is displayed at the bottom of the screen, in a
table Description of the test Codes and Results. It is sorted in alphabetical order.

The “Close” button returns you to the Review Screen.

6.6 Statistics and Message Notes

Below the Organism Results section, additional information is displayed. Up to two additional
sections can be displayed based on the identification results (Statistics, Message or Error section).

The Statistics section gives comments about the reliability of the confidence value.

The Ciystal ID Report i1s based on these statistics. Choosing an organism of the basis of these statistics i1z not | =
recommended.

The confidence value is the degree of certainty for that identification. A value of 1.0 would indicate
100% certainty. The statistic, Biotype Validity, is a measure of the “nearness of fit" between your result
and a hypothetical "best fit" profile number. The larger the value, the worse the agreement between
your profile and the profile for the listed organism or group. The direct use of these statistics to report
identifications is not part of the BBL CRYSTAL Identification System. Values are displayed for
information only. Relatively close values should be considered equivalent (1000 is approximately as
meaningful as 5000, for example).

The Message section gives comments about the final results. Some organisms display additional
information about the organism(s) in the Message box.

The Crystal ID system reports these choices. Supplemental testing is recommended.

The Error section is displayed instead of the Message section, if a value higher than 3 has been
entered as the first digit of a fluorescent panel profile number. The section is displayed in red indicating
that the panel can not be calculated.

This Crystal profile indicates a positive result on the fluorescent control. A negative result is expected. Crystal
cannot calculate an ID.

44
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6.7 Edit/Modify a Panel Profile

It is possible to correct potential errors while reviewing the Identification(s) suggested by the system.

NOTE

The Edit feature is not available if the desired panel has one or more
equivocal results. The equivocal results must be resolved before the Edit
feature is enabled. See Section 6.8 for information on resolving equivo-

cal results.

To edit a panel, click the “Edit” button and the Data Entry screen is displayed with the selected panel
on the screen.

BBLCrystal Microbiology INteractive Database [Data Entry] .

File BatchID Review Reports Setup Percentage

Accession #

Modify |Pali8nl Id | |Palienl MName

ENF

A[BICIDIETFIGIH]TJ]

HOO0OO000000

ARA MMNS SUC MEL RHA SOR MMNT ADD GaL MO

IQOOOOOOOOD | Crapomatny

FHO BGL MPG PRO BPH BxY 4AR PHC GLR NAG

HQQQQOQQQQQ (® Mouse Entiy

GGL ESC PHE URE GLY CIT MLO TTC &RG LYS

Close

Oxidase | [Indole
[+ s
5 @-

You may now modify the biochemical reactions and the offline tests of the current panel. At this time,
you may also enter equivocal results. Only the selected panel from the Review Screen can be
modified. The associated panels can only be modified by selecting each panel individually in the
Review Screen and then clicking the “Edit” button.

When you have made all the changes, click the “Modify” button to save the panel. The Batch Id
process is automatically re-launched and will give new identifications, and Statistics for the given
panel.
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To review the new identification results for the modified panel, you must select the Review menu item
at the top of the screen to return to the Review screen. Now you must re-select the desired panel in
the worklist.

6.8 Resolving Equivocal Results

The panels that have equivocal results are indicated in the worklist by an asterisk (*) after the panel
abbreviation.

£ Patignt M ame n Mumber

ENF 5664646051 H FREEMAN 827444 -
ENF 4765273163 J DELL 284737

EMF |~ |5664646051 JOHN DOE 382288

ENF G76567 7557 R BOOKMAN H46732

ENF 3411310300 5 REYHOLDS 537272

ENF h761673455 T SMITH 827218 | hat
l 3

When a panel with equivocal reactions is highlighted in the worklist, the attached results are displayed
in the organism section (just like panels without equivocal results).

BBLCrystal Microbiology INteractive Database [Review] .
File DataEntry BatchID Reports Setup  Percentage
Prafile Patierit M ane i ioh Murber

EMF 5664646051 H FREEMAN 827444 -

EMF 4765273153 J DELL 284737

ENF | |5664646051 JOHN DOE 382288

EMF G76D67 70567 B BOOKMAN h46732

EMF 3411310300 5 REYHNOLDS 537272

Delete ENlF 5761673455 T SHITH 827218 | hd
- 4 »
[ Display the Prafiles already Printed List Sorted by
Sup. Test Patient Mame @ Accession Mumber O
[ Cumrent Record
() Others - — Biotype Validity | [ Confidence 1
[1] Citrobacter Freundii I:l I:l
Resolve
The Ciystal ID Report is based on these statistics.
Cloze

BBL Crystal Enteric/MF 4.0
Profile I:I Oxidase |:| Indole |:|

When a panel with equivocal results is selected in the worklist, two additional buttons appear at the left
of the screen: “(*) Others” and “Resolve.” Their use is described in the sections that follow.
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6.8.1 (*) Others

The “(*) Others” button allows you to display the current profile and the other possible profiles
based on selecting the opposite reaction for each of the equivocal biochemicals. When you click
the button, the current worklist is cleared and is replaced with all the possible profile numbers for
the current panel.

All the possibilities have an “*” (asterisk) following the panel abbreviation except for the current
profile.

Farel Frafile

EMF 5664646051
EMF [* [5624646051
ENF 5664646251
ENF 5624646251

# of combinations based on the # of equivocal biochemicals:

1 equivocal biochemical = 2 different combinations
2 equivocal biochemicals = 4 different combinations
3 equivocal biochemicals = 8 different combinations

As you select each profile in the list, the Organism identification results for that profile appear. The
next step is to select a profile for this panel or to cancel the operation. The following describes the
three buttons that are available.

“Resolve” — Resolves the panel by selecting the highlighted profile as the final result for the
panel. The new results are saved to the database and all equivocal marks are removed from
the panel.

"Cancel” — Returns to the previous Review screen with all the original panels displayed in the
worklist. The panel remains unchanged and still has equivocal results.

“Sup Test” — Displays supplemental testing results.

6.8.2 Resolve

If you choose the original profile (the one displayed in the initial worklist), you have to highlight the
panel line and press the “Resolve” button to resolve the equivocal biochemicals. The “(*) Others”
and “Resolve” buttons are removed from the screen once the highlighted panel has been resolved.
The asterisk after the panel abbreviation for this panel in the worklist is also removed.

6.9 Deleting a Panel

If the “Delete” button is clicked, a message is displayed on the screen asking to confirm the delete. If
you answer Yes, the selected panel is deleted from the database.

A panel can be deleted with or without equivocal test results.

If all panels attached to an accession number are deleted, the accession number is deleted from the
database. If all accession numbers attached to a patient are deleted, the patient is deleted from the
database.
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6.10 Close

If the “Close” button is clicked, the Review screen is closed and the main BBL Crystal MIND screen is
displayed.
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7.0 Reports

7.1 Specimen Report

The Specimen Report contains panel results for all panels associated to the accession (that were
entered at the same time) or for a single panel. Each panel of the specimen is printed on a separate

page.

NOTE

Once a panel has been printed it is removed from the Worklist on the
Review Screen. Make sure that the printer is turned on and has paper
prior to printing a Specimen Report. If the printer is turned off, out of
paper or some other technical difficulty has occured, the panel(s) are still
assumed to be printed and will be removed from the Worklist. To be able
to re-print the panel, you must check the Display the Profiles already
Printed check box.

This displays all the panels in the database that have already been
printed

[ Display the Profiles aleady Printed

The Specimen Report can be generated two ways: from the Reports Menu or through the “Print”
button on the Review screen. The two printing methods are described below.

L-005355(J)
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7.1.1 Printing from the Reports Menu

To print the Specimen Report through the Reports Menu, click on Reports and then click on

Specimen Report. This prints all specimens that have passed through the Batch ID process and
have not yet been printed.

BBLCrystal Microbiology IMteractive Database
File DataEntry BatchID  Review BEEbiies

Setup  Percentage  Reference Test

Specimens Reporks
I Recapitulative Report

7.1.2 Printing from Review screen

To print the Specimen Report through the Review Screen, select a panel in the worklist and then
click the “Print” button. Only the selected panel is printed. Note that panels related to the selected
panel are not printed, (as when printing from the Reports menu), only the selected panel prints.

7.1.3 Example Report

BBLCrystal MIND - Specimen Report

152004 16:03:46

Accession # : 82357
Patient Id : 235
Patient Name : JOHN DOE
Profile : 1671000131 BBL Crystal Gram Positive 4.0
Gram + Cocci
Streptococcus pneumoniae Streptococcus mitis group
Biotype © 6 Biotype : 8 Biatype -
Confidence Factor: ~ 0.5189 nfidence Factor © 0.3505 nf E:
The Streptococcus mitis group includes:
mitis and Streg oralis.
Statistics : The Crystal ID Report is based on these statistics. Choosing an organism of the basis of these statistics is not recommended.
Message Report : The Crystal ID system reports these choices, Suppl 1 testing is

Final Id :
Atypical Reaction :

STRMITGR

50

L-005355(J)



BBL Crystal™ MIND User’s Guide

The report provides the following data:

A Report Header with the current date and Report title.
A Specimen Header containing the Accession number, Patient Id and Patient Name.

A Panel Results Section containing the Profile number, Panel Type, Offline Test Results,
Organism Id(s) with corresponding Biotype and Confidence factor, and messages.

If there is more than one identified organism, then supplemental test information is given for
each of the identified organisms to help you choose a supplemental test to determine a final
identification for the panel. An area is provided that enables you to record the results of any
supplemental tests that you may have run, as well as an area to record the Final ID.

An Atypical Reaction section which displays the expected reaction for biochemicals that
deviated from the expected reaction.

7.2 Recapitulative Report

The Recapitulative Report is a summary of all the panels that received organism results within a
specified date range. A specimen that has not passed through the Batch ID process does not have any
of its panels included in the Recapitulative Report.

The report is printed by selecting the Report menu from the Main menu and then selecting
Recapitulative Report. Once you select the report, you are prompted for a start and end date. The
date range defaults to the current day. Click the “OK” button and the report is sent to the printer.

Refer to the Troubleshooting section of this manual if the report does not print.

Recapitulative Report .

Hezult Date Hange ‘

From |1u;23;2mu |Tu |1n;23;2mu |

L-005355(J)

51



BBL Crystal™ MIND User’s Guide

7.2.1 Example Report

E’.ELCryst;ll MIND - R;:Iéapitul;t_ive Repdn:f_ C wsmos ——  wsnoos

/32004 10:55:42

Accession # : Patient Name : Profile : Gram : Indole:  Oxidase: Ea;talase: Organism :
101 QC PANEL R 7777777777 ENF TR e i
| #2372 T J_OHZN DOE 6765677557 ENF - - KLEPNEP : o
| SERRUB
| ENTCLO
43726 JOHN DOE 0665553503 GP + Cocei STRAGA ()
| * R5662 JANE DOE 0732000170 GP + Bacﬁ]l__ 7 ACTPYO

() Please review panel results in Review Screen for Special "Message" information.

The report provides the following data:

* A header with the report title, the selected date range and the current date.
*  For each profile:

Accession number

Patient name

Profile and panel name

Offline Test results (Oxydase, Indole, ...)

Identifications with the corresponding Confidence factor and Biotype. An exclamation
mark (! ) indicates that there is an associated Message Taxon that can be viewed in the
Specimen Report or Review display.
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8.0 Set Up

8.1 Introduction

The Setup Menu enables you to add/modify user accounts in the system and modify the passwords of
existing user accounts. To run the BBL Crystal MIND application, you must have a user account
defined in the system.

The default user account is the following:
Username: BBL Crystal
Password: BBL

There are two levels of account security: Technologist and Administrator. If you are logged into the
system under an account that has a Technologist security level, then you do not have access to the
Account Password menu item.

Percentage Reference Test

Change Password

Account Password
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8.2 Change Password

This menu is accessible for all users and enables you to change your password for the current account
that you are logged under.

To change your password, you need to enter your current password in the first field (Old Password).
In the second field (New Password), enter the new password. In the third field (New Password
Validation) you must once again enter your new password, for confirmation.

Password Modification

|l]|||:| Pazsword I
|New Password I
|Hew Password Yerification

| ‘ | Cancel |

When you access the screen, the “OK” button is disabled. It becomes active once you have completed
all three fields. You can cancel your changes by clicking the “Cancel” button.

When the “OK” button is clicked: If the old password is not correct or if the new password is not the
same as the New Password Verification, an error message is displayed and the change does not take
place.

54
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8.3 Account Password

This submenu is accessed by clicking on the Setup menu and then clicking Account Password. It is
only accessible for a user with an Administrator security level. It may be used to Add, Edit, or Delete
user accounts.

When entering this screen, the list of all users with their respective security level (Administrator or
Technologist) is displayed.

Security Account Setup .

‘User Name Security Level ‘

Add Level 1 - Administrator
bhl crystal Level 1 - Adwmwinistrator
Thomp son Christopher Lewvel £ - Technologist

Edit

Delete

Close

L-005355(J) 55



BBL Crystal™ MIND User’s Guide

8.3.1 Adding a New User Account

To add a new user, click the “Add” button. A window is displayed where you need to enter the Last

AND First name of the new user. Enter up to 24 alphanumeric characters in the Last name and up
to 25 characters for the First name.

" Uzer Mame " Security Level
=i £ Level 1 [Administrator]
| |
First @ Level 2 [Technologist]
Save |
Cancel
—

You must choose the user's security level by clicking the Level 1 (Administrator) or Level 2
(Technologist) radio button.

Click the “Save” button to add the new user to the database. If all fields are not completed, an error
message is displayed informing that the save cannot take place.

If you wish to cancel the addition of the new user, click the “Cancel” button and the Main screen is
displayed.

NOTE

Each username MUST be unique. If not, an error message is displayed.

56
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8.3.2 Modifying a User Account

You must first select a user account in the list on the Account Password screen. Now click the
“Edit” button to display the account information for the selected user.

This screen functions as described in Section 8.3.1 for adding a new user account.

If the user of the account that is being modified has forgotten his/her password, click the check
box, Reset Password to Last Name to reset the password to the user's last name. When the user
logs in the next time, they can change the password through the Change Password option.

8.3.3 Deleting a User Account

To delete a user account, you must first select a user account in the list on the Account Password
screen. Now click the “Delete” button.

A message is displayed asking you to confirm or cancel the deletion of the selected user.

NOTE

It is impossible to delete the current logged on user. An error message is
displayed if this is attempted.
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9.0 Percent Chart

9.1 Introduction

The Percent Chart is a display only informational chart that lists the percentages of each biochemical
for each organism. The numbers displayed in the chart represent the percentage of strains positive for
the tested biochemical in the BBL Crystal Database.

The menu option to display the Percent Chart is available in any screen.

Al Microbiology INteractive Database

Entry BatchID Review Reports Setup FPercentage Reference Test

L-005355(J) 59



BBL Crystal™ MIND User’s Guide

Lloze

{ENF ! ANE | ANE | ANR | &P RGP | HH
CLC J SCH | ALT
SUC MPG PHE MEL PRO URE RH:
lcinetobacter baumannii h8 |4 16 |99 |1 1 4 1 4 9% |1 37 (25 .
icinetobacter Iwoffi 1 |1 1 1 1 1 1 1 1 4 1 N1
/Aeromonas caviae 75 |8 83 |28 |B1 [5H8 (97 |99 |11 |1 99 |92 |1
eromonas hydrophila 49 (44 (79 (B6 (81 |72 |86 |99 |11 |4 99 (81 |11
Aeromonas sobria 4 |64 |72 |99 [12 |1 9 |99 [16 |1 99 |88 |1
Aeromonas veroni 20 |20 |60 (8D (60 |60 (93 |99 |60 |1 39 |80 |1
hgrobacterium tumefaciens 1 |8 1 1 92 (99 |1 31 |1 1 8 99 |1
Cedecea davizae 35 |18 (41 (99 |99 (99 |33 |82 |1 1 1 1 |1
Cedecea lapagei 14 |29 |71 (99 |99 (99 |14 |93 |1 57 |1 64 |14
Cedecea neten 1 |20 (40 |99 (99 |99 (99 (99 |1 1 1 20 |1
Chromobacterium yiolaceum 1 (99 (80 |1 1 1o |1 1 10 |1 10 |90 |1
Pzeudomonas luteola 1 |55 |1 1 93 |93 |1 9 1 5 |36 (99 |36
Citrobacter amalonaticus a3 |4 67 |99 (25 |13 |4 9 1 g 4 38 |93
Citrobacter koseri a3 |3 83 |99 (8 4 41 (96 |1 1 1 40 |99
Citrobacter freundii a3 |7 90 |99 (9 2 A7 (98 1 72 1 31 |93
E dwardsiella hozhinae 9 1 1 9 |1 1 9 1 1 1 9 |1 1
E dwardziella tarda 1 |56 [1 99 |6 1 1 1 1 1 99 |38 1
Enterobacter aerogenes 97 |29 |9% (99 |97 |99 (98 |85 |1 9% |1 2 93
Pantoea agglomerans 89 |42 |68 (97 (B9 |76 (B2 |84 |11 |53 |3 26 |89
Enterobacter azburiae a9 |7 g0 |99 (99 |87 99 9% |1 13 1 0 |13
Enterobacter cloacae 98 |60 91 (99 |41 (40 |99 99 1 A |7 43 |88
Enterobacter gergoviae 94 (59 (88 (99 (99 |99 (99 |94 |12 |A1 |47 |99 (99
Enterobacter sakazakii 99 |63 |84 (99 |84 (89 |99 99 |5 53 |26 (37 |89
E nterobacter cancerogenus 99 (94 (6% (99 (82 |76 |18 |99 |12 |18 |6 59 |99
E scherichia coli 99 |9 5 |99 (5 7 48 (99 1 g2 132 1 94
E zchernichia coli zerotype 0111 99 1 1 99 |1 1 99 (99 |1 60 (1 40 |99
E zchernichia coli serotype 0157 99 1 1 99 |7 1 86 (96 |1 929 [1 1 99
E zcherichia coli AD 89 |1 1 1\ |1 1 11 (56 |1 5 |11 (44 |33
E zcherichia fergusonii B!|] 19 (31 (99 (19 |6 13 99 |1 [ 1 i1 L
4 »
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10.0 Reference Test

10.1 Introduction

NOTE

This section only applies if you have an attached BBL Crystal
AutoReader.

To insure that the AutoReader is correctly calibrated, you must periodically read a Reference Panel in
the AutoReader. The Reference Panel is provided with the purchase of your BBL Crystal AutoReader.
Scanning the Reference Panel in the AutoReader provides either a Pass or Fail status.

To scan the Reference Panel, select the Reference Test menu item from either the Main Menu, Data
Entry Menu or the Review Menu.

ktal Microbiology INteractive Database !E .
ta Entry BatchID Review FReports Setup Percentage Reference Test

The AutoReader drawer automatically opens and a screen is displayed instructing you to place the
Reference Panel in the AutoReader. Once you have placed the panel in the AutoReader, click the
“Scan” button to initiate the scanning process. When the scan of the panel is complete, a message
appears that indicates the success or failure of the Reference Panel Test. Regardless of the test
status, you can remove the panel from the AutoReader and then click the “Close” button to exit the
screen. Upon exiting, the AutoReader drawer automatically closes and you are returned to the Main
Screen.
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If the Reference Panel passed the test, you can continue to use your AutoReader. If the Reference

Panel failed the test, you must contact BD Technical Service for assistance.

NOTE

Do not continue using the AutoReader if the reference panel test failed.
Please contact BD Technical Service.
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11.0 Configuration

11.1 Introduction

The system has three configuration options that can be modified via the “MIND Setup” icon in the “BBL
Crystal MIND” program group.

NOTE

When modifying a configuration option, you must first exit the BBL
Crystal MIND application. Make your modifications then restart the
application.

The three available configuration options are the following:
» Data Review Period
» Panel Reaction Entry — Mouse vs. Keyboard

« Communications Port for BBL Crystal AutoReader

11.2 Data Review Period

The panel data stored in the database is never deleted. You do have the option however, to limit the
number of panels that are displayed in the Review Screen (when the checkbox “Display the Panels
already Printed” is checked). To limit the number of panels that are displayed, you can set a parameter
that indicates the number of days prior to the current date to keep active.
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The default period is 30 days. This number can be changed to any number of days that you desire.
Note, however, if this number is too large, the Worklist in the Review screen may be truncated. You will
be notified if the list is truncated. If this parameter is set to 0, the data displayed in the worklist is the
data for the current day only. If the parameter is set to 1, the data displayed is the data of yesterday
and today.

To modify the default setting, exit the BBL Crystal MIND application and double-click on the “MIND
Setup” icon. This automatically opens the configuration file “crystal.ini” in a text editor. Perform the
following steps:

1 Use your arrows keys to move to the section [Setup].

Under the [Setup] section is the configuration setting “Periode.”
Place your cursor at the end of the “Periode” line.

Change the default number (30) to the desired number.

a b~ W N

If this is the only configuration option that you want to change, then follow the steps below,
otherwise proceed to the appropriate section in this manual to modify another configuration
option.

Click the File Menu and select Save.
Click the File Menu again and select Exit.

11.3 Panel Reaction Entry

When entering positive/negative reactions in the virtual panel on the Data Entry screen, you have two
options of data entry: Keyboard or Mouse. The default option when the Data Entry screen is entered,
is Keyboard. You can change the setting while in the Data Entry screen by clicking the appropriate
radio button. Each time the Data Entry screen is entered, the default setting of Keyboard is always
selected.

To modify the default setting to Mouse, exit the BBL Crystal MIND application and click on the “MIND
Setup” icon. This automatically opens the configuration file “crystal.ini” in a text editor. Perform the
following steps:

1 Use your arrows keys to move to the section [Setup].

Under the [Setup] section is the configuration setting “Keyboard.”
Place your cursor at the end of the “Keyboard” line.

Change the default setting of “False” to “True.”

a b~ W N

If this is the only configuration option that you want to change, then follow the steps below,
otherwise proceed to the appropriate section in this manual to modify another configuration
option.

6 Click on the File Menu and select Save.
Click on the File Menu again and select Exit.
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11.4 Communications Port Configuration

You have the option of modifying the communications port setting that was setup during the installation
of the BBL Crystal MIND application. You have the following options:

Changing the com port of a connected AutoReader: Change existing com port setting to a new
com port number.

Disconnecting an AutoReader: Change existing com port setting to “0.”

Connecting a new AutoReader: Change com port setting of “0” to appropriate com port number.

To modify the communications port setting, exit the BBL Crystal MIND application and double-click the
“MIND Setup” icon. This automatically opens the configuration file “crystal.ini” in a text editor. Perform
the following steps:

1

2
3
4

Use your arrows keys to move to the end of the file, to the section [Communications].
Under the [Communications] section is the configuration setting “CommPort.”
Place your cursor at the end of the “CommPort” line.

Change the current com port number to the appropriate number based on one of the three
options above.

If this is the only configuration option that you want to change, then follow the steps below,
otherwise proceed to the appropriate section in this manual to modify another configuration
option.

Click on the File Menu and select Save.

Click on the File Menu again and select Exit.
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12.0 Working with the
Keyboard

12.1 Global Rules

The BBL Crystal MIND application can be operated via just the use of the Keyboard. There are global
keyboard rules which apply to all screens:

To activate a column menu

There is one underlined letter in the menu option. Use “Alt” + “X” (where X is the underlined letter)
to view the column menu.

To activate an option in the column menu

There is one underlined letter for each option under the menu. Press the “X” (where X is the
underlined letter) to activate the option.

To activate a pushbutton :

There is one underlined letter in the name of the push button. Use “Alt” + “X” (where X is the
underlined letter) to activate the button.

To check a check box

When the focus is on the label of the required check box, press the spacebar to select the check
box. An “X” appears in the box. To uncheck it, press the spacebar again.

To move through the fields
Use “Tab” to move forward from field to field.

Use “Shift” + “Tab” to move backwards from field to field.
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To select aradio button (Keyboard/Mouse, Indole, etc)

Use “Tab” to go to the desired field.

Use the up and down arrow keys to select the desired radio button.
To move through the push buttons

When the focus is on a pushbutton, use the up and down arrow keys to highlight the desired
pushbutton.

Press “Enter” to activate it.
You can also use “Alt” + “X” to access the button directly.
To move through items in a scrollable list (Review worklist, User Accounts list, etc)

Use the up and down arrow keys to go through the list. The selected line is highlighted.
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